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IT & ITES                             Related Theory for Exercise 1.7.39 to 1.7.41
COPA - Spread Sheet Application

Introduction to MS-Excel 2010
Objectives :   At the end of this lesson you shall be able to
• features & Functions of Microsoft Excel
• formulas and Functions
• move Around in Excel 2010
• conditional Formatting
• link Excel Spreadsheet Data

Features & Functions of Microsoft Excel
Whether for work or home use, an Excel spreadsheet is
the best tool in Microsoft Office for organizing data and
making lists. Although Word documents can include
tables and columns, Excel makes laying out information
for easier. Excel also has a range of functions for designing
formulas that automate calculations. Although Excel looks
intimidating at first, the program's layout is similar to other
Office applications.

Cells and Worksheets
The main portion of Excel's window consists of a
spreadsheet -- or worksheet of cells. Just as with a paper
spreadsheet, each cell can contain any numbers or any
text -- unlike working with an Access database, Excel
allows to simply click on any cell and fill it however best
fits the project.

In some cases, such as to track spending, if want to use
an organized series of rows and columns. Other times,
such as building a list of team members, cell order and
positioning won't play a major role. One advantage to
Excel is how simple it makes reorganizing data: select a
cell and drag its border to move it to a new spot on the
sheet.

Excel Workbooks
Every Excel file, called a workbook, contains one or more
worksheets. To switch between sheets in a workbook,
use the tabs in the lower left corner of the window. Since
Excel 2010, most workbooks use the file extension XLSX,

whereas older versions used XLS files. New copies of Excel
can read these old files, but to open a new workbook in an
old edition, the old PC needs the Office compatibility pack.

Formulas and Functions
In addition to containing plain text and numbers, cells
can contain formulas, which always start with an equals
sign. With a formula, Excel displays the result of an
equation in a cell, but automatically keeps that result
up-to-date as you change its components. A basic formula
can take the place of a calculator: write "=2+4" and Excel
displays "6." Formulas also work with data in other cells:
"=A1+B1" adds the values of cells A1 and B1.

For procedures other than direct arithmetic, use functions
to perform various operations on data. Functions' abilities
range from simple math, such as "AVERAGE" to average
a range of cells, to modifying text, such as "LOWER" to
convert a line to lower case.

The two terms are often confused, but remember that
each cell can contain only one formula, but each formula
can use multiple functions, such as "=AVERAGE(A1,
B1)+SUM(A2, B2)" to add the sum of two cells to the
average of two other cells.

The following basic window appears when you start the
excel application. Let us

now understand the various important parts of this window
as shown in fig-1.

Ribbon Tabs
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As with the rest of Office since 2007, Microsoft has
replaced Excel's menus with ribbon tabs as shown in
fig-2. The tab as visual menus that remain open each
tab contains a set of related features with explanatory
icons. For example, the Home tab contains the most
common options, such as font and text color, while the
Insert tab offers ways to insert tables, text boxes and
charts. One tab, File, behaves differently. File still
contains basic tasks including "New," "Open" and "Save,"
but displays these tasks in a full-screen area with extra
options, called the backstage view. For example, the
"New" button in the backstage view offers a searchable
selection of templates for new workbooks.

Ribbon contains commands organized in three

Insert: Use this when adding particular elements (including
graphics, PivotTables, charts, hyperlinks, and headers and
footers) to a spreadsheet. This tab is arranged into the
Tables, Illustrations, Sparkline, Filter, Charts, Links, and
Text groups.

Page Layout: Use this tab when preparing a spreadsheet
for printing or reordering graphics on the sheet. This tab
is arranged into the Themes, Page Setup, Scale to Fit,
Sheet Options, and Arrange groups.

Formulas: Use this tab when adding formulas and
functions to a spreadsheet or checking a worksheet for
formula errors. This tab is arranged into the Function
Library, Defined Names, Formula Auditing, and
Calculation groups. Note that this tab also contains a
Solutions group when activate certain add-in programs,

Data: Use this tab when importing, querying, outlining,
and subtotaling the data placed into a worksheet's data
list. This tab is arranged into the Get External Data,
Connections, Sort & Filter, Data Tools, and Outline
groups.

Review: Use this tab when proofing, protecting, and
marking up a spreadsheet for review by others. This tab
is arranged into the Proofing, Language, Comments, and
Changes groups. Note that this tab also contains an Ink
group with a sole Start Inking button if you're running
Office 2010 on a Tablet PC or on a computer equipped
with some sort of electronic input tablet.

View: Use this tab when changing the display of the
Worksheet area and the data it contains. This tab is
arranged into the Workbook Views, Show, Zoom,
Window, and Macros groups.

Fig 1
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components:
Tabs: They appear across the top of the Ribbon and
contain groups of related commands. Home, Insert, Page
Layout is the examples of ribbon tabs.

Groups: They organize related commands; each group
name appears below the group on the Ribbon. For
example, group of commands related to fonts or group
of commands related to alignment etc.

?Home: Use this tab when creating, formatting, and
editing a spreadsheet.

This tab is arranged into the Clipboard, Font, Alignment,
Number, Styles, Cells, and Editing groups.
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Title Bar
This lies in the middle and at the top of the window. Title
bar shows the program and the sheet titles.

Help
The Help Icon can be used to get excel related help
anytime you like. Thisprovides nice tutorial on various
subjects related to excel.

Zoom Control
Zoom control lets to zoom in for a closer look at your
text. The zoom control consists of a slider that user can
slide left or right to zoom in or out. The + buttons can be
clicked to increase or decrease the zoom factor.

View Buttons
The group of three buttons located to the left of the Zoom
control, near the

bottom of the screen, lets to switch among excel's various
sheet views.

Normal Layout view: This displays the page in normal
view.

Page Layout view: This displays pages exactly as they
will appear when printed. This gives a full screen look of
the document.

Page Break view: This shows a preview of where pages
will break when printed.

Sheet Area
The area where to enter data. The flashing vertical bar
is called the insertion point and it represents the location
where text will appear when type.

Row Bar
Rows are numbered from 1 onwards and keeps on
increasing as to keepentering data. Maximum limit is
1,048,576 rows.

Column Bar
Columns are numbered from A onwards and keeps on
increasing as to keep

entering data. After Z, it will start the series of AA, AB
and so on. Maximum limit is 16,384 columns.

Status Bar
This displays the sheet information as well as the insertion
point location. From left to right, this bar can contain the
total number of pages and words in the document,
language etc.

user can configure the status bar by right-clicking
anywhere on it and byselecting or deselecting options
from the provided list

File Tab
The File tab replaces the Office button from Excel 2010.
user can click it to check the Backstage view, where
user come to open or save files, create new sheets, print
a sheet, and do other file-related operations.

Quick Access Toolbar
TheFile tab and its purpose is to provide a convenient
resting place for the Excel's most frequently used
commands. And  customize this toolbar based on the
comfort.

Dialog Box Launcher(Fig-3)
This appears as a very small arrow in the lower-right
corner of many groups on the Ribbon. Clicking this button
opens a dialog box or task pane that providesmore
options about the group.

If already have an opened sheet then it will display a
window showing the

details about the opened sheet as shown fig-4. Backstage
view shows threecolumns when select most of the
available options in the first column.

First column of the backstage view will have the following options as shown in

Table-1:

Option Description

Save If an existing sheet is opened, it would be saved as is,otherwise it will display a dialogue
box asking for thesheet name.

Save As A dialogue box will be displayed asking for sheet nameand sheet type. By default, it will
save in sheet 2010 format with extension .xlsx.

Open This option is used to open an existing excel sheet.

Close This option is used to close an opened sheet.

Info This option displays the information about the openedsheet.

Fig 3
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Recent This option lists down all the recently opened sheets.

New This option is used to open a new sheet.

Print This option is used to print an opened sheet.

Save & Send This option saves an opened sheet and displays options to send the sheet using email etc.

Help You can use this option to get the required help about excel 2010.

Options Use this option to set various option related to excel 2010.

Exit Use this option to close the sheet and exit.

Sheet area is the place of type the text. The flashing vertical
bar iscalled the insertion point and it represents the location
where text will appearwhen type. When click on a box
then the box is highlighted. When double click the box,
the flashing vertical bar appears and can start entering the
data.

So, just keep the mouse cursor at the text insertion point
and start typing whatever text would like to type. We
have typed only two words "HelloExcel" as shown fig-6.
The text appears to the left of the insertion point.

Option Description

Sheet Information
When click Info option available in the first column, it
displays the following information in the second column
of the backstage view:

Compatibility Mode: If the sheet is not a native excel
2007/2010 sheet, a Convert button appears here,
enabling to easily update its format. Otherwise, this
category does not appear.

Permissions: This option used to protect the excel sheet.
And can set a password so that nobody can open the
sheet, or lock the sheet so that nobody can edit the sheet.

Prepare for Sharing: This section highlights important
information should know about the sheet before send it
to others, such as a record of the edits the made as
developed the sheet.

Versions: If the sheet has been saved several times,
and may be able to access previous versions of it from
this section.

Sheet Properties
When click Info option available in the first column, it
displays various properties in the third column of the
backstage view. These properties include sheet size, title,
tags, categories etc.

user can also edit various properties. Just try to click on
the property value and if property is editable, then it will
display a text box where can add the text like title, tags,
comments, Author.

Entering values
A new sheet is displayed by default when open an excel
sheet as shown in the fig-5 screen shot.

Fig 5
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There are following three important points, which would help while typing:
• Press Tab to go to next column.

• Press Enter to go to next row.

• Press Alt + Enter to enter a new line in the same
column.

Move Around in Excel 2010
Excel provides a number of ways to move around a sheet
using the mouse and the keyboard.

OrderDate Region Rep Item Units Unit Cost Total

1/6/2010 East Jones Pencil 95 1.99 189.05

1/23/2010 Central Kivell Binder 50 19.99 999.5

2/9/2010 Central Jardine Pencil 36 4.99 179.64

2/26/2010 Central Gill Pen 27 19.99 539.73

3/15/2010 West Sorvino Pencil 56 2.99 167.44

4/1/2010 East Jones Binder 60 4.99 299.4

4/18/2010 Central Andrews Pencil 75 1.99 149.25

5/5/2010 Central Jardine Pencil 90 4.99 449.1

5/22/2010 West Thompson Pencil 32 1.99 63.68

6/8/2010 East Jones Binder 60 8.99 539.4

6/25/2010 Central Morgan Pencil 90 4.99 449.1

7/12/2010 East Howard Binder 29 1.99 57.71

7/29/2010 East Parent Binder 81 19.99 1,619.19

8/15/2010 East Jones Pencil 35 4.99 174.65

First of all, let us create some sample text before we
proceed. Open a new excel sheet and type any data. A
sample data table as shown table-2 and fig-7.

Table-2Fig 7
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Moving with Mouse

Mouse can easily move the insertion point by clicking in
the text anywhere on the screen. Sometime if the sheet
is big then user cannot see a place need to move. In
such situations, to use the scroll bars, as shown fig-8
screen shot.
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Fig 8
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user can scroll the sheet by rolling mouse wheel, which
is equivalent to clicking the up-arrow or down-arrow
buttons in the scroll bar.

Moving with Scroll Bars
As shown in the above screen capture, there are two
scroll bars: one for moving vertically within the sheet,
and one for moving horizontally. Using the vertical scroll
bar, user may ?

• Move upward by one line by clicking the upward-
pointing scroll arrow.

• Move downward by one line by clicking the downward-
pointing scroll arrow.

• Move one next page, using next page button
(footnote).

• Move one previous page, using previous page button
(footnote).

• Use Browse Object button to move through the sheet,
going from one chosen object to the next.

Moving with Keyboard
The following keyboard commands, used for moving
around your sheet, also move the insertion point -

Keystroke Where the Insertion Point Moves

Forward one box

Back one box

Up one box

Down one box

PageUp To the previous screen

PageDown To the next screen

Home To the beginning of the current screen

End To the end of the current screen

User can move box by box or sheet by sheet. Now click
in any box containing data in the sheet. It would have to
hold down the Ctrl key while pressing an arrow key, which
moves the insertion point as described here -

Key Combination Where the Insertion Point
Moves

Ctrl + To the last box containing data
of the current row.

Ctrl + To the first box containing data
of the current row.

Ctrl + To the first box containing data
of the current column.

Ctrl + To the last box containing data
of the current column.

Ctrl + Page Up To the sheet in the left of the
current sheet.

Ctrl + Page Down To the sheet in the right of the
current sheet.

Ctrl + Home To the beginning of the sheet.

Ctrl + End To the end of the sheet.

Moving with Go To Command
Press F5 key to use Go To command as shown in fig-9,
which will display a dialogue box contains various options
to reach to a particular box.

Normally, we use row and column number, for example
K5 and finally press Go To button.

Fig 9
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Conditional Formatting
MS Excel 2010 Conditional Formatting feature enables
to format a range of values so that the values outside
certain limits, are automatically formatted.

Choose Home Tab " Style group " Conditional Formatting
dropdown.

Various Conditional Formatting Options
• Highlight Cells Rules ? It opens a continuation menu

with various options for defining the formatting rules
that highlight the cells in the cell selection that contain
certain values, text, or dates, or that have values
greater or less than a particular value, or that fall
within a certain ranges of values.

Suppose to find cell with Amount 0 and Mark them as
red. Choose Range of cell " Home Tab " Conditional
Formatting DropDown " Highlight Cell Rules " Equal To as
on fig-10.

Fig 10
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After Clicking ok, the cells with value zero are marked as
red as shown in fig-11.

Fig 11
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• Top/Bottom Rules: It opens a continuation menu
with various options for defining the formatting rules
that highlight the top and bottom values, percentages,
and above and below average values in the cell
selection.

Suppose want to highlight the top 10% rows user can do
this with these Top/Bottom rules as shown in fig-12.

Fig 12
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• Data Bars(fig-13): It opens a palette with different
color data bars that can apply to the cell selection to
indicate their values relative to each other by clicking
the data bar thumbnail.

With this conditional Formatting data Bars will appear in
each cell.

Fig 13
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• Color Scales (Fig-14): It opens a palette with different
three- and two-colored scales that can apply to the
cell selection to indicate their values relative to each
other by clicking the color scale thumbnail.

See the below screenshot with Color Scales, conditional
formatting applied.
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Fig 14
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• Icon Sets (Fig-15)? It opens a palette with different
sets of icons that can apply to the cell selection to indicate
their values relative to each other by clicking the icon
set.

See the below screenshot with Icon Sets conditional
formatting applied.

Fig 15

• New Rule: It opens the New Formatting Rule dialog
box, where define a custom conditional formatting rule
to apply to the cell selection.

• Clear Rules: It opens a continuation menu, where
can remove the conditional formatting rules for the cell
selection by clicking the Selected Cells option, for the
entire worksheet by clicking the Entire Sheet option, or
for just the current data table by clicking the This Table
option.

• Manage Rules: It opens the Conditional Formatting
Rules Manager dialog box, edit and delete particular rules
as well as adjust their rule precedence by moving them
up or down in the Rules list box.

Link Excel Spreadsheet Data
Microsoft Excel provides the ability for cells in one
worksheet to be linked to cells in one or more other
worksheets. This is a great productivity tool and can
reduce the need for additional worksheets!

Linking Excel Worksheet Data Overview
In Excel, a link is a formula that dynamically pulls in
data from a cell in another worksheet. The worksheet
can be in the same workbook or a different workbook.

The destination worksheet is the worksheet that contains
the link formula. The worksheet containing the data that
will be brought in is called the source worksheet.

Any time the cell value in the source worksheet changes,
the cell containing the link formula will be updated as
well the next time the spreadsheet containing the link
formula is opened. This is just one of many reasons the
Excel software program is so powerful.

Need for Linking Spreadsheet Data
The ability to create links often eliminates the need to
have identical data entered and updated in multiple
sheets. This saves time, reduces errors, and improves
data integrity. For example, a company's prices can be
stored in a 'Master Price List' worksheet, and others
needing pricing data can link to that worksheet.

Consider a Sales Manager who has a detailed
spreadsheet for each salesperson, but would like a
summary sheet to compare salespersons' performance
and create grand totals. The summary sheet (destination)
would bring in data from all the salespersons' sheets
(source).

Create the Worksheet Link

Before creating the link, format the cell
containing the link formula in the destination
worksheet to equal the format of the source data.

For example, if the data from the source spreadsheet is
currency with 2 decimal points, then first format the target
cell for currency with 2 decimal places.

METHOD ONE
1. In the source worksheet, select the cell need to link

to and click the Copy button on the Home tab. Or
press Ctrl+C, or right-click and select Copy.

2. Switch to the destination spreadsheet and click the
cell want to link. Then, depending on the version of
Excel:

• Excel 2007, 2010, and 2013: On the Home tab, click
the down arrow below Paste and click Paste Link. In
newer versions also right-click and select the Paste
Link from the Paste menu.

• Excel 2003 and older versions: On the Edit menu,
click Paste Special, and then click Paste Link.

3. Return to the source worksheet and press ESC to
remove the animated border around the cell.

METHOD TWO
This is a fast method that works in a different order than
Method One.

1. In the destination worksheet cell that will contain the
link formula, enter an equal sign (=).
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2. In the source worksheet, click in the cell that contains
the data and press the Enter key.

Link Formula Example(Fig-16)
In the example below, using Method One, we click in cell
B6 in the source worksheet and click Copy. Then, on the
destination worksheet, we click in cell B3, and paste the
link. The value ($3,500) automatically displays.

Follow the same steps to link the data from the Denver
and Seattle worksheets to the Store Totals worksheet.
And first formatted the cells to display the data as Currency.
(Fig 16)
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